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INTRODUCTION

This document aims to provide general recommendations and configurations for network switches to be used
with Powersoft amplifiers for Dante and AES67 connectivity, including practical examples.

For remote control and monitoring of amplifiers, any type of network switch running on at least 100 Mbps will
be sufficient. However, for transport of Audio-over-IP like Dante or AES67, dedicated network switches and
configurations may be necessary.

This is specially the case of large and heavily loaded, or mixed, networks (e.g. audio + video + other data types).

The following are general recommendations when working with networks, especially in the case of larger
networks:

e Topology — Although “daisy chaining” may be suitable for connecting devices in a network, the failure
of any device in the chain will break connections to devices further down in the “stream”. In general,
switched networks are best thought of when using a “star”, or “hub and spoke” topology. In such a
setup, all devices on a star are connected to a single switch and, if any device fails, the others continue
to communicate. As the network gets larger, additional switches may be brought in to extend the
network. The star topology can be easily extended in a multiple-star arrangement to suit larger systems
(Figure 1).

Device
5

Device
§]

Device Switch

8

Figure 1 — Example of a multiple-star topology, where no device is more than 4 “hops” away from any other.

e (Cabling — Any type of ethernet cable is suitable for a Dante or AES67 network, although, in gigabit
speed network, CAT5e or CAT6 cables are recommended. CAT6 cables are rated for greater noise
resistance in electrically noisy environments, however, CAT5e is enough for most applications. The
maximum allowed length for a normal ethernet cable is approximately 100m. For longer distances,
fibre optics will be necessary, as it can run for several kilometres when required. The drawback is that
fibre connections will require network interfaces that can support it, such as Small Form-Factor
Pluggable (SFP).
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GENERAL RECOMMENDATIONS FOR DANTE & AES67

DANTE: What is it?

DANTE audio network is a network audio protocol by Audinate that transport uncompressed, multi-channel,
low-latency digital audio over a standard ethernet network, using layer 3 internet protocol packets.

AES67: What is it?

AES67 is a standard (not a protocol) defined by the Audio Engineering Society for audio over IP interoperability.
It ensures interoperability between previously competing networked audio protocol.

AES67 defines requirements for synchronizing clocks, setting QoS priorities for media traffic, and initiating
media streams with standard protocols among all other networking specifications.

For maximum Dante and/or AES67 network reliability, it is recommended that switches be/have:

e Rated for gigabit Ethernet —although 100Mbps may be enough for a small and audio-dedicated network,
larger and heavier installations may require a switch running on at least 1Gbps.

e Non-blocking — in this type of device (almost every switch nowadays), all ports can run at full speed
without any loss of data packets. The switch can handle the total bandwidth on all ports, establishing
routing to any free output port without interfering with other traffic.

e EEE" (Energy Efficient Ethernet) DISABLED — switches that do not have energy efficient or energy save
mode do not require any additional configuration.
However, this function needs to be disabled in switches that offer it, as it will impede proper operation
of low-latency audio over IP.
The energy-save function tends to delay packets sent over the network.

*EEE is also sometimes referred to as ‘Green Ethernet’ or ‘IEEE 802’. Beware that some unmanaged switches
have EEE enabled by default and will not allow the user to disable this function.
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Managed — differently from unmanaged switches (plug-and-play), managed switches offer a series of
different options and adjustments, such as the ability to prioritise the transport of certain types of data
over others, and creating Virtual Local Area Networks (VLANs), which are particularly important in mixed
networks, where audio is combined with other types of data. For small and audio-dedicated networks,
unmanaged switches may be sufficient for Dante and AES67 operations. However, in heavily loaded
networks, or where audio streams share the network with other data (e.g. video, security, etc.), a
managed switch will likely be necessary.

Quality of Service (QoS) management — only available in managed switches. QoS network management
allows the switch to prioritise certain types of data packets over others. Such packets get preferential
treatment and are “moved to the front of the line" ahead of other traffic (Figure 2). In the case of audio
streams, the priority must first be given to clocks for device and audio signal synchronization, followed
by the audio packets themselves. This is to guarantee low-latency and high-quality audio streams across
the network. Dante networks require at least four priority queues, whilst AES67 only requires three.

FIRST

ECONOMY

Other Packets Audio Packets Clock Synchronisation

Figure 2 — Sketch of different priority queues for audio data management in an AES67 network.
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e Differentiated Services Code Points (DSCP) QoS — DSCP is a type of QoS management. To prioritise the
different packets of information, Dante/AES67 networks use DSCP labels and numbers to organise these
packets in different priority queues. Such management is done by the switch and, therefore, where
managed network switches are necessary, these must work with DSCP QoS.

Many switches have Layer 2 “CoS QoS” management enabled by default, and this configuration needs
to be changed to Layer 3 “DiffServ/DSCP QoS”. Once enabled, check the priority assignments. The switch
will require special configuration to recognise and prioritise the specific DSCP values used by Dante
(Table 1) and by AES67 (Table 2). A configuration example is covered later in this document.

PRIORITY QUEUES ‘ USAGE DSCP LABEL DSCP NUMBER
1. High Clock synchronisation CS7 56
2. Medium Audio packets EF 46
3. Low Video packets/Reserved Cs1 8
4. None Other packets Best-Effort 0

Table 1 — DANTE’s different priority queues and their respective DSCP values.

PRIORITY QUEUES DSCP LABEL DSCP NUMBER
1. High Clock synchronisation EF 46
2. Medium Audio packets AF41 34
3. None Other packets Best-Effort 0

Table 2 — AES67’s different priority queues and their respective DSCP values.

In mixed networks with Dante and AES67 streams generated from a Dante device, it is always recommended
that the DSCP values from Table 1 are used, and that clock synch packets always receive the highest priority
treatment.

Values in Table 2 should only be used in AES67 networks that do not contain Dante streams.

IMPORTANT NOTE:

In larger Wide Area Network (WAN) connections, such as those used in large corporate environments, DSCP
tags may not be respected by edge routers.

Consult your network administrator to discuss options to bypass this constraint if it exists.
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RECOMMENDATIONS FOR MULTICAST TRAFFIC

The following switch configurations apply to networks containing multicast data traffic. Dante devices may be
configured to transmit either unicast or multicast audio streams, while AES67 only works with multicast
transmission.

For Dante, unicast data traffic will require less switch and routing configurations, making it a simpler and faster
solution for small and dedicated networks, under normal circumstances. However, in larger scenarios, and
specially where multiple devices receive the same audio stream, the use of multicast over unicast for audio
transmission may be beneficial. If correctly configured, multicast can be more efficient than unicast in terms
of bandwidth consumption.

For maximum multicast efficiency and reliability, it is recommended that network switches have:

IGMP Snooping Activated — When using multicast traffic, it is important to configure the network
accordingly to increase efficiency and reduce bandwidth consumption. Without a proper configuration
to manage this traffic, multicast packets will be broadcast to all receivers in the domain, including
devices that have not requested those packets (Figure 3). This could be a problem to some amplifiers
that may not be able to manage a high count of incoming data packets. To overcome this issue, IGMP
Snooping must be activated in the network switch.

Internet Group Management Protocol (IGMP) is a communication protocol used to establish multicast
groups and manage memberships of receiving and transmitting devices. When a multicast
transmission starts, a multicast group is created and an announcement is sent to all devices over the
network, after which, devices wishing to receive the multicast packets, will send IGMP join messages,
specifying the IP multicast group they want to join.

IGMP Snooping is the process where the network switch examines the IGMP communications
between devices to create a table with which multicast packets are needed and in which of its ports.
In this process, the switch will only forward multicast data packets to the designated ports and
receivers (Figure 3).

Multicast without IGMP Snooping Multicast with IGMP Snooping

YaYd
NN

Figure 3 — Difference between multicast packet transmission with and without IGMP Snooping in operation.
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For a stable IGMP Snooping operation, an IGMP Snooping Querier must also be enabled. The aim of a
querier is to keep the table with all the multicast group memberships up to date. It sends out IGMP
queries on a timed interval to all members belonging to the IP multicast group. All devices wishing to
remain in the group must reply to the query with a confirmation. Those devices that do not respond
within a defined amount of time will be removed from the group’s table and will no longer be
forwarded those multicast streams.

Although a network can accommodate multiple IGMP Snooping Queriers (and will automatically select
one), it is safer to have only one IGMP querier enabled, preferably on a switch sitting close to the root
of the network topology.

Some switches also allow the configuration of a ‘Query Interval, which is related to the group
membership timeout, and is the number of seconds that must pass before the switch determines that
no more members of a multicast group exist on the network. When the ‘Query Interval’ is large, the
time required for the multicast stream to start or stop working becomes longer and the user may
experience than an amplifier will take longer to start playing audio.

An example of IGMP Snooping configuration for a Cisco switch is given later in this document.

Finally, IGMP has three different versions: v1, v2, and v3. However, IGMPv2 supports IGMPv1, and
IGMPv3 supports IGMPv2. Although not all features of an earlier version of IGMP are supported, the
features related to membership query and membership report messages are supported for all IGMP
versions.

For Dante and AES67, IGMPv2 or IGMPv3 are recommended.
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Powersoft Amplifiers AolP table summary

Unica

9K4
12K4
16K4
2K8
4K8
8K8

Dante Rx

AES67 Rx

Dante Tx

AES67 Tx

Mezzo Series

Quattrocanali Series

Duecanali Series

602 AD
324 AD
322 AD
322 AD

AN N NENE Y Y SN NN

RN NN RN N N NENEN

604 A+
602 A+
324 A+
322 A+

NN NN NN ENE NN NN

8804 DSP+D
4804 DSP+D
2404 DSP+D
1204 DSP+D

RSN

8804 DSP+
4804 DSP+
2404 DSP+
1204 DSP+

6404 DSP+D
4804 DSP+D
1604 DSP+D

804 DSP+D

RSN

6404 DSP+
4804 DSP+
1604 DSP+

804 DSP+

NENE NN N N NN N N N L N NN N NN N N NN N SN NENEN
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Dante Rx  AES67 Rx  Dante Tx  AES67 Tx

4K4 DSP+D N4 v v v

Ottocanali Series 8K4 DSP+D v N4 v v
12K4 DSP+D v v v v

X8 D v v v v

X Series X4L D V4 v v v
X4 D v v v v

604 J v v v

T Series 002 v v v v
304 V4 v v v

302 N v v v

Table 3 — List of AolP protocols and compatibility with Dynamic Music Distribution.
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DANTE SETUP AND OPERATIONS

Connecting Powersoft Amplifiers to a Dante Network

Physical connection to a Dante network is done via regular CAT5e (or higher) wiring. If a switch is used, special
attention should be given to its capabilities, as certain products are not compatible with Dante Networks.

For more information on switch requirements for Dante compatibility, and on how to create and manage Dante
networks, please refer to Audinate’s website.

When opening the ‘Dante Controller’, all devices connected to the Dante network will be displayed in the list
of transmitters and receivers (Figure 4).

& Dante Controller - Network View - a X

Eile Device View Help

(L] €7 | #| i/ &) ()| @ srandMaster dock: seriesirizes i@

Routing; Device Info  Clock Status Network Status
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Figure 4 — Dante Controller Network View window.

If the computer in use features multiple network ports, in some instances, ‘Dante Controller’ may connect to
the wrong one. To overcome this issue, click on the square next to ‘P:” at the bottom left corner of the ‘Network
View’ window. This will open the Dante interface configuration window (Figure 5), from where the correct port

can be selected.

& Configure Dante Interfaces in Unmanaged mode X

Select the network interface that the Dante Controller
will use to communicate with other Dante devices (in unmanaged mode):

Use shared Dante interface

Ethernet 3 v
IP: No Address
MAC: B4:45:06:11:BA:3A

Primary Interface:

|1|:|x|' None v
IP: No Address

MAC: 00:00:00:00:00:00

Secondary Interface:

Figure 5 — Configuration of Dante network interfaces.
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Powersoft amplifiers connected to the Dante network will automatically obtain IP addresses by default, and in
most circumstances, there is no need to change the address settings. However, static IP addresses can be
assigned if necessary.

To assign a static IP address:

Open the ‘Device View’ window by double-clicking on the device to be configured.
Click on the ‘Network Config’ tab (Figure 6).

Under ‘Addresses’ switch to the option 'Manually configure an IP Address'

Enter the IP Address and Netmask.

Click ‘Apply’.

uiAswN e

The DNS Server and Gateway settings are optional- the device will use network defaults if they are not
specified. To revert to the previous settings, click ‘Revert’.

It is important to note that this operation requires a device reboot. This can be done by simply clicking ‘Reboot’
under ‘Reset Device’. However, in some instances, it has been verified that a manual reboot of the amplifier is
necessary for modifications to take effect and is therefore recommended as best practice.

& Dante Controller - Device View (XSeries171283) — O ®
Eile Device View Help
=T BEER = 2]

Receive Transmit Status Latency Device Config Metwork Config  AESS7 Config

Switch Configuration
Current: Switched

New: Switched ~

Addresses

(@) Obtain an IP Address Automatically (default)

(0) Manually configure an IP Address
IP Address:

Netmask:

DNS Server:

Gateway:

Apply Revert

Reboot Clear Config

|—REsEt Device

Figure 6 — Dante Controller ‘Network Config’ tab in the ‘Device View’ window.

Please note that when Powersoft amplifiers are set to automatically obtain IP addresses, Dante Controller must
be running on a host computer also configured to obtain IP addresses automatically. Likewise, for static IP
address configurations, fixed IP addresses must be assigned to both host computer and amplifier, with both
devices operating within the same subnet.
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The assignment of fixed IP to a Powersoft amplifier can also be done via ArmoniaPlus. Figure 7 is showing the
IP assignment page of the amplifier’s Dante setting in ArmoniaPlus.

Workspace Systemlist  Views Designer Health+ X8 Dante

Any changes to this settings will reboot the board x

Figure 7 — ArmoniaPlus ‘Network Config’ window in the ‘Dante Settings’ tab.

Other Dante settings, as Dante device name, Dante latency, sample rate and AES67 mode, can be edited via
ArmoniaPlus, in the same Dante settings page as shown in Figure 7.
For advanced Dante settings Audinate Dante Controller software must be used.

Network interface configuration: Switched, Split, Redundant

Powersoft amplifiers may feature one or two Dante ethernet ports. Amplifiers with a single Dante port also
feature an additional standard Ethernet port, with each port operating independently from one another. In
amplifiers where two Dante ports are available (labelled primary and secondary), it is possible to switch
between different operation modes:

e Switched Mode- The secondary Dante port behaves as a standard switch port, allowing daisy-chaining
through the amplifier (Figure 8). This is the default configuration for Powersoft amplifiers with two
Dante ports.

A 12
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ArmoniaPlus

Armonia-Plus
System Manager

@Dante

- DSP Control

Dante N

ncna‘hac‘af_ H

Dante

DSP Control + Dante

NEVER CLOSE THE LOOP!

Figure 8 — Example of Dante Switched Mode configuration with Powersoft amplifiers.

Split Mode- For amplifiers with a single Dante port and one Ethernet port, this is the default and only

operation mode available. In amplifiers with two Dante ports, ‘Split Mode’ can be selected, allowing
the primary port to behave as a regular Ethernet port operating independently from the Dante

network (Figure 9).

= DSP Control

Dante

Remote control

Armonia+Plus
System Manager

Figure 9 — Example of Dante Split Mode configuration with Powersoft amplifiers.

10).

Redundant Mode —When an amplifier is set to ‘Redundant’, it will duplicate the Dante audio traffic to
both Dante ports, allowing the implementation of a redundant network via the secondary port (Figure

13
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= i
H ADante Dante Primary
1 A— L— Dante Secondary
DSP Control + Dante
L '
(=P ¥ =] m| (O 5

- EFEEE P
j Primary Network

) Sastesete
I HEHITHE
H [lli::-ll |ﬂi‘5l @}_I Secondary Port

Secondary Network

H O

Figure 10 — Example of Dante Redundancy Mode configuration with Powersoft amplifiers.

AES67 CONFIGURATION ON DANTE DEVICES

Powersoft amplifiers support a limited number of audio streams, also known as ‘flows’ — the actual number
varies by device according to the Dante card it utilizes. In general, ‘Dante Ultimo’ cards allow for a maximum
of 2 transmit flows and 2 receive flows to be created, while amplifiers with ‘Dante Brooklyn II’ cards can
simultaneously stream 32 x 32 flows.

Table 4 below presents a summary of all Dante enabled Powersoft amplifiers and their flow streaming
capabilities.

) ) . Dante
Ultimo UXT  Ultimo UXT Ultimo ULT Brooklyn Il Embedded
(2x2flows)  (2xO0flows)  (2x0flows)  (32x32flows) Platform
Unica 4L y
(4 x 4 flows)
Unica 8M y
(8 x 8 flows)
Mezzo AD v
Quattrocanali DSP+D * v 4
Duecanali DSP+D*? v v
Ottocanali DSP+D v
X Series v
T Series? v

Table 4 — List of Dante-enabled Powersoft amplifiers’ number of Rx and Tx flows.
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NOTE 1: Quattrocanali DSP+D and Duecanali DSP+D amplifiers cannot transmit Dante flows.

NOTE 2: Four-channel versions of T Series amplifiers can be configured to have channels as either 4-IN/4-OUT at 48 kHz
or 4-IN/0-OUT at 96kHz. Selection can be done in ArmoniaPlus, in the amplifier’s internal configurations, under Options
> Dante Settings > Device Configuration.

The Dante modules in Powersoft amplifiers operate with their own dedicated firmware. To ensure a correct
configuration of AES67, it is recommended that all modules are running the latest Dante firmware.

The following firmware versions are recommended for Dante cards in Powersoft amplifiers:
e Brooklyn Il —version 2.0.1.0 or above.

Ultimo UXT (T Series) — version 2.1.3.0 or above.

Ultimo UXT (Quattrocanali and Duecanali Series) — version 4.1.1.4 or above.

Ultimo ULT—version 3.10.4.1 or above.

More information on how to update the Dante firmware in Powersoft amplifiers can be found on Powersoft’s
website.

Enabling AES67 and Receiving Flows

Before setting up an AES67 connection between an amplifier and a third-party device, it is necessary to enable
AES67 streaming on the amplifier. This is done via the software application ‘Dante Controller’ provided by
Audinate. Free download versions of the software are available for ‘Windows’ and ‘Mac OS X’ directly on
Audinate’s website.

When opening ‘Dante Controller’, all devices connected to the Dante network will be displayed in the list of
transmitters and receivers.

To enable AES67 streaming:
1. Open the Device View window by double-clicking on the device to be configured.

2. Select the AES67 Config tab® (Figure 11).
3. Under ‘AES67 Mode’ select ‘Enabled’ from the drop-down list.
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@ Dante Controller - Device View (8CH-70238) — O *

File Device View Help
£ BN @ < [H o BCH-70256 z 7]

Receive Transmit Status Latency Device Config Metwork Config AES67 Config

AES67 Mode

Current:  Enabled

Mew:

Tx Multicast Address Prefix

Current Prefie: 239,690 XXX

MNew Address Prefix: set

Reset Device

Reboot Clear Config

Figure 11 — Dante Controller AES67 Config tab in the Device View window.

NOTE 1: If the AES67 Config tab is not showing in the amplifier’s device view, the most likely solution for this issue is to
update the firmware of the Dante card. More information can be found on Powersoft’s website.

It is important to note that this operation requires a device reboot. This can be done by simply clicking ‘Reboot’
under ‘Reset Device’. However, in some instances, it has been verified that a manual reboot of the amplifier is
necessary for modifications to take effect and is, therefore, recommended as best practice.

The above operation will automatically enable the amplifier to receive AES67 streams, and in most
circumstances, this is the only necessary configuration. However, some amplifiers can also be set to transmit
AES67 audio streams over the Dante network.

Transmitting AES67 Flows

Although enabling AES67 in the ‘Dante Controller’ automatically configures the amplifier to receive AES67
streams, an additional step is necessary if transmitting audio streams is desired.

In Dante, there are two types of audio streams, or ‘flows’: Unicast and Multicast. Unicast flows are one-to-one
routes that deliver audio to and from specific devices, and support 4 channels of audio simultaneously. A
multicast flow “broadcasts” the audio so that multiple receivers can subscribe to it, but the transmitting device
is only using one of its available flows. It allows up to 8 audio channels to be streamed in one flow.

When connecting two devices in Dante Controller, a unicast transmit flow is automatically created by default
from the transmitter to the receiver. However, AES67 connections only utilise multicast flows, as this is a
universal communication method used by most network systems. Therefore, it is necessary to create a
multicast flow for the channels of the AES67 transmitting device.

To create a multicast Dante flow and enable AES67 streaming from a transmitting device:

16
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1. Open the Device View window by double-clicking on the transmitting device to be configured.
2. Click on the ‘Create a new multicast’ button at the top bar.

<

3. Inthe ‘Create Multicast Flow’ window, tick the box next to ‘AES67 Flow’ (Figure 12).
Select the channels to be included in the multicast flow.
5. Click ‘Create’

&

& Create Multicast Flow X
8CH-70256 supports up
to 4 channels per flow.
RTP flows for AES67 have a maximum of 8 channels per flow.
Select one or more transmit channels to be placed in multicast flows.
Audio Flow Config (Optional)
(O Dante (@) AESE7
Destination Address: @ Auto (O Manual
Channel 0 Add to
Name New Flow
() Dante OUT1
() Dante OUT2
{3 Dante OUT3 O
() Dante OUT4 O
Create Cancel

Figure 12 — Dante Controller ‘AES67 Config’ tab in the ‘Device View’ window.

A list of all the transmit flows created for the device, including multicast AES67 flows, can be found in the
Device View window, under the Transmit tab.

Important note: Dante Controller gives the user the option to save all the routing information as a preset by
clicking on the “Save preset” button % . Itis however strongly advised that the preset feature is not used,
as loading saved presets in Dante Controller will erase all patching previously made with AES67 devices.
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AES67 CONFIGURATION ON AES67 ONLY AMPLIFIERS

Powersoft DSP+ and Mezzo A+ models can be set up to receive audio over IP streams compliant to AES67
interoperability standard.

This section describes how to properly configure the amplifier and patch it to a compatible AES67 stream using
the software ArmoniaPlus.

AES67 specifications

AES67 is a technical standard for audio applications of networks that allows high-performance streaming
Audio-over-IP interoperability between different networking systems. All Powersoft amplifiers featuring a
Dante card can be configured to work with AES67 audio streams according to Audinate’s compatibility
specification by enabling the “AES67 mode” via ArmoniaPlus or Dante controller.

Powersoft DSP+ and Mezzo A+ models can receive AES67 streams natively when connecting the dedicated
network port labelled “AolP” to your AES67 network.

Network port configuration for DSP+ models is Split Mode and cannot be changed: the two ports have their
own IP Address that can be configured in DHCP mode (default configuration) or in Static mode. The first port
“Ethernet” is used for remote control via ArmoniaPlus or third-party clients while the second port “AolP” is for
receiving AES67 compatible streams.

Network ports for Mezzo A+ models can be configured to Split Mode or Switched Mode. In Split Mode, the two
ports have their own IP Address that can be configured in DHCP mode (default configuration) or in Static mode.
While on Switched Mode, both ports have a single IP Address and would act as an internal switch for the
amplifier containing both control and AES67 stream:s.

Table 5 describes the specification of AES67 streams supported by DSP+ models:

AES67

Discovery SAP/SDP

Network Multicast

Packet Time 1ms

Sample Rate 48 kHz

Encoding L24

Channels Up to 8 per stream

Table 5 — DSP+ and Mezzo A+ AES67 specifications.
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AES67 settings

The AES67 chipset in DSP+ and Mezzo A+ amplifiers can be configured accessing the “AES67 settings” tab
available in the option of the amplifier (Figure 13).

Parameters available are:

e Device Name

e |P address (DHCP or Static)
e Sample rate (fixed at 48kHz)
e latency

M _ &8 X
AMP: Quattrocanali 1204 DSP+ DSP: 50%

Systemlist  Operator View
AESST settings

16925420632

Figure 13 — AES67 settings window in ArmoniaPlus.

The latency parameter can be set according to the network bandwidth available and the desired

performances.
A higher latency value is suggested to have more stability and avoid audio dropouts or clock issues.
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AES67 patching

Patching a DSP+ or Mezzo A+ amplifier to receive an AES67 stream is a very easy operation through
ArmoniaPlus:

1. Connect your PC with ArmoniaPlus to both remote control and AES67 network.
2. Openthe ‘Communication Manager’ and enable the Dante/AES67 button to allow ArmoniaPlus to scan
for AES67 streams (Figure 14).

Preferences

Network Interfaces

COMMUNICATION MANAGER Name Address ArmoniaPlus | Dante™ / AES67 |

Powersoft 10.151.13.60 oN MW L

Intel(R) Dual Band Wireless-AC 3165

Figure 14 — ArmoniaPlus Communication Manager.

3. Click “Ok” to confirm and close the window.

4. Goto the tab “Config” and select the “Input” function.

5. Select the input of the amplifier that you want to patch. (Multiple input selection is available when
using same amplifier series).

6. Click on the desired priority box and select “AES67” on the amplifier input column.

7. Choose the AES67 Rx channel of the amplifier that you want to be patched.

8. Select the Tx stream in the “Network devices” column and the source channel (Figure 15).

Powersoft DSP+

Remote control

AES67 stream > R =tone

AES67-TX-1

PRIORITIES
st

.. AES6T1 > S o g B
** CHOT- AESET-TX-1 a2 o I

Design | Config| Tune  Show . I Input

Figure 15 — AES67 input patching window.
Patching a DSP+ or Mezzo A+ amplifier can also be done through the amplfiers designated Web Interface.
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To access the amplifers Web Interface enter the AolP port unique IP address into your web browser (Figure
16).

General Settings

Input Patching

Figure 16 — DSP+ and Mezzo A+ Web Interface.

Patching Rx flows can be completed within the “Input Patching” section of the Web Interface.

Transmitting AES67 Flows with Mezzo A+

The AES67 Chipset for Mezzo A+ models allow users to convert any analog stream to AES67 or to re-transmit
on the network any other AES67 input.

To convert an analog stream to AES67 (or to transmit a digital input on the output channels of the AES67
chipset) select the “AES67 settings” tab available within the option tab of the amplifier. The user can leave the
transmitter channel selection to “Auto” mode* or choose the desired “Pick Point” (Figure 17).

e  Physical IN

e Source Selection
e Matrix

e QOut

e Out Current — Used for third-party output current readings
e Out Voltage — Used for third-party output voltage readings

* NOTE: when creating a DMD System the transmission of AES67 streams is done automatically and “Auto” checkbox
must be flagged. If the user is not creating a DMD System “Disabled” label will be showed instead of “Auto” and, if
flagged, the Tx channels of AES67 chipset will be disabled.
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Figure 17 — Mezzo A+ AES67 Settings Tab.

Completing the patch is made within ArmoniaPlus (Figure 18).

ALSET-TXY

Figure 18 — Patching a Mezzo A+ AES67 Tx to DSP+ Rx.

Thanks to this Mezzo’s capability it is possible to have available over the AES67 network an analog source
physically connected to the amplifier.

With DMD Systems this allows to share to all the Zones of the project an Analog source that is not physically
connected to the same amplifier of the Zone-related speakers (this sharing is done automatically by the
system).

With non-DMD systems this feature allows the users to have available an analog source as AES67 input over
the network, to be used, for example, as a new input for Canali DSP+ Series amplifiers.
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POWERSOFT AMPLIFIERS AND Q-SYS NETWORKING VIA AES67

The following notes are applicable to Q-SYS and Powersoft amplifiers connections via an AES67 network.
Powersoft has also made a series of free plug-ins and communication protocols available for the control of
amplifiers directly from the Q-SYS Designer platform.

The integration of Powersoft amplifiers and a Q-SYS AES67 network is done via Dante Controller and the
additional software application ‘Q-SYS Designer’, which can be downloaded directly from QSC’s website.

Before creating any AES67 connections with Q-SYS, verify that the properties of Q-SYS Designer match those
of Dante ‘Quality of Service’ (QoS) management. This is specially the case for networks running both AES67
and Dante streams.

In Q-SYS Designer go to File > Design Properties (Figure 19). Under ‘QoS Preset’ select ‘Audinate’ from the drop-
down menu.

Design Properties X
PTPv2 Domain Default (0) v
PTP Priority 1 254 °
PTP Priority 2 100 z
PTP Force On Off ~
MTU Value 1500 >
QoS Preset Audinate v
PTPv2 DSCP Value 56
Audio DSCP Value 46
Video DSCP Value 26

Software Dante

Receive Latency 2ms v

Interface LAN A A

OK Cancel

Figure 19 —Matching Q-SYS Designer properties with Dante QoS management properties.

The operation above assumes that Dante streams are present in the network, therefore, any network switch
in place must be configured to work with a Dante network, i.e., with the DSCP parameters shown in ‘Figure 19".

If no Dante streams are present and only AES67 streams are used in the network, the switch may be configured
following DSCP parameters suggested by QSC, and in such case, ‘QLAN’ should be the QoS preset selected.

If no Dante streams are present and only AES67 streams are used in the network, the switch may be configured
following DSCP parameters suggested by QSC, and in such case, ‘QLAN’ should be the QoS preset selected.
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AES67 from Q-SYS to Powersoft Amplifiers

For this operation, the amplifier must first be configured in Dante Controller so that AES67 streaming is
enabled. This is done by following the steps described in the section ‘Enabling AES67 and Receiving Flows’ of

this document.

To set up a Q-SYS AES67 transmitter:

1. Open Q-SYS Designer.

2. Inthe Inventory pane, click the ‘+" symbol to add a device.

3. Select the option Streaming 1/O and then AES67 Transmitter (Figure 20).

Peripherals
Streaming 1/0

Amplifiers | AESE7 Receiver
Loudspeakers AESET Transmitter
Media Stream Receiver
Media Stream Transmitter
Q-LAN RX
Q-LAN TX
Softphone
WAN Receiver
WAN Transmitter

AESGET 48kHz Interop
AESET 48kHz Interop
Virtual receiver
Virtual transmitter
Virtual Q-LAN Receiver, for Core-to-Core streaming in
Virtual Q-LAN Transmitter, for Core-to-Core streaming cut
SIP/WelP based telephony endpoint

Virtual wan receiver

Virtual wan transmitter

Figure 20 — List of streaming devices available in Q-SYS Designer.

4. An AES67 Transmitter device will be added to the Inventory list. Click, drag, and drop this device as a
component onto the design schematic window (Figure 21).

Eile Edit

Inventory
4 Default

View Tools Help

« a Page 1 X | (%] Q-5¥S Configurator

Design Elements

b4~ Per

Location

4 ABSHT TX: AES67-TX-1

Status/Control

4 @ Core 110f: Core110f

Status
Mic/Line In

Flex In

AESET Transmitter
AES67-TX-1

CoOOQo000

Figure 21 — AES67 Transmitter device in Q-SYS Designer.

5. Click on the AES67 Transmitter component to view its properties under the Properties Pane. Set
‘Connection Mode’ to ‘Auto’ and edit the ‘Channel Count’ to the number of channels to be transmitted
from Q-SYS to the amplifier in the AES67 flow (Figure 22). It is important to note that it has been
verified that changing the ‘Channel Count’, without deleting/redoing the patching in Dante Controller,
creates audible HF distortion in the audio signal.
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[Y Page1 x + -

Properties
= AESSET Transmitter Properties
8 Mame AES6T-TX-1
O AES6T Transmitter Location Default Location
8 o el Connection Mode Auto
8 Channel Count a
Graphic Properties
Fill

Figure 22 — AES67 Transmitter properties in Q-SYS Designer.

6. Save the design to the Q-SYS Core by pressing F5 or selecting File > Save to Core & Run.
7. Double-click the AES67 Transmitter component to open the Connection pane (Figure 23).

AES6T Transmitter AES67-TX-1
Stream | Details
Channel f h

1 2 3 4 b 6 7 ]

AESET [

Peak Output Level
(dBFS)

L [-120d8]-120d8] -120d8] -120d8 [ -120d8 [ -120d8 [ -120d8 [ -120d8]

Digital f Cip | ® @ L] e & & @ L]
Clip Hold | (I (NN (N (D O D D
Invert | (D (DD I D O D D
Mute | (I (D S N B N S .

Gain | 7ode ][ ocs || ods || ods || ods || ods || ods || ods
A A oy
X

Status
@ oK
=

Connection

=)

Address | 2396900 m0c |

Enable [ enstle |
Stream Name | AESET-TH-1 |
Network Tx Buffer [ Defauit |
Interface | LAN A |

Figure 23 — AES67 Transmitter Connection pane.

8. Note that the AES67 Transmitter automatically assigns a name to the ‘Stream Name’. The AES
Transmitter device is now available for connection with other AES67 devices and can be seen in the list
of Dante Transmitters in Dante Controller (Figure 24).
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& Dante Controller - Metwork View
File Device View Help
(L €2 m * & &S| H @
éDevice Info Clodk Status  Metwork Status  Events
H H HE
. R
@Dante HE
o N
H—. o aE
=21 1=1:
. N m= L 2
Filter Transmitters @ g @ W
a-J -] > E
| 2 s
= )
£ ]
Filter Receivers g !
o
m =
| I
g 2
= f
a [
+
+||~| Dante Receivers
+/BCH-70256 &
+/pC + F F
+/Q2404-00413752 =+ [+ [FH E
+/XB8-171285 4 [ [

Figure 24 — The AES67 Transmitter in Dante Controller.

9. Note from ‘Figure 21’ that Q-SYS has automatically assigned an IP address to the AES67 Transmitter
flow (239.69.xxx.xxx). This default configuration is appropriate when only one AES67 Transmitter
component is used in the Q-SYS design schematic. However, when several transmitter components are
added to the design, Q-SYS will incorrectly assign the same IP address to all AES67 flows. In such
instance, it is recommended to manually configure the IP of the ‘Multicast Address’ in each transmitter
component independently (Figure 25).

Connection 7

Multicast Address | 230.69.0.1 |
Enable

Stream Name | AESET-TX-1 |

Metwork Tx Buffer | Default |

L Interface | LAM & L

Figure 25 — Manual configuration of the ‘Multicast Address’ for an AES67 Transmitter.

For best practice, it is recommended that static multicast IP addresses are always used for Q-SYS AES67
Transmitter flows, as it will make the network routing more reliable. This is specially the case when devices
are restarted and/or put in a different network, causing the IP addresses to change and the routing to be lost.

Patching of AES67 streams to a Powersoft amplifier can be done either from Dante Controller (for a Dante
based amplifier on AES67 mode) or ArmoniaPlus or via a dedicated webpage on the amplifier (for AES67 only
amplifier).

A 26

DO000312.00 REV.00



NETWORK SWITCH CONFIGURATION EXAMPLE: CISCO SG350

The following is an example of how to configure a Cisco switch with some of the key parameters for a correct

Dante/AES67 operation.

The configurations page for most switches can be accessed by typing its IP address in any web browser address
bar. For this to work correctly, the computer must be in the same IP range/subnet of the switch it is connected
to. By default, Cisco switches are in the IP range 192.168.1.X and the configuration web page can be accessed

by typing “192.168.1.254” in the URL bar.

To change the computer’s IP address and subnet mask, in WINDOWS:

1. Connect the computer to any of the switch ethernet ports.

2. On a Windows PC, access the Ethernet Status window (Figure 26). Usually this is done from the

‘Network and Sharing Centre’, by clicking on ‘Ethernet’ from the active networks.

3. In the Ethernet Status window, click on ‘Properties’ to open the Ethernet Properties window, select

‘Internet Protocol Version 4 (TCP/IPv4), and click ‘Properties’ (Figure 27).

4. Inthe TCP/IPv4 Properties window, select ‘Use the following IP address’ to configure a static IP address

for the PC (Figure 28).

5. Typeinan IP address following 192.168.1.X; where X can be any number from 1 to 253, assuming there
are no other devices in the same subnet connected to the switch for which one of those numbers has

already been allocated.

6. Under Subnet Mask, type in 255.255.255.0, and click ‘OK’.

;‘: Ethernet Status
General

Connection

IPv4 Connectivity: Mo network access
IPv6 Connectivity: No network access
Media State: Enabled
Curation: 01:00:07
Speed: 1.0 Gbps
L Detdlss,

Activity
Sent “-"E Received

Bytes: 23,008,680,798 12,956,786

!;Eropemes Gglsab\e Diagnose

Close

% Ethernet Properties
Netwarking

Connect using:

Ia Intel(R) 82574L Gigabit Network Connection

Corfigure
This connection uses the following items:

0% Client for Microsoft Networks A
SFHE and Printer Sharing for Microsoft Networks

SQDS Packet Scheduler

B e Frolocol Version 4 (TCP/IPvd) |

& Link-Layer Topology Discovery Mapper 140 Driver

[ -2 Microsoft Network Adapter Muttiplexor Protocol

-2 Microsoft LLDP Protocol Driver v
< >

Install... Uninstall
Description

Transmission Control Protocol/Intemet Protocol. The defautt
wide area network protocol that provides communication
across diverse interconnected networks

0K Cancel

Figure 26 — Ethernet Status window.

After the configuration of the switch is done, remember to revert the operation by selecting ‘Obtain an IP

Figure 27 — Ethernet Properties.

Internet Protocol Version 4 (TCP/IPv4) Properties

General

‘You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(0 Obtain an IP address automatically
(®) Use the following IP address:

[P address: 192,168, 1 . 10
Subnet mask: 255,255,255 . 0

Obtain DNS server address automatically

(@) Usg the following DNS server addresses:

L. - - ]
L. . . ]

Preferred DS server:

Alternative DNS server:

[ validate settings upon exit Adyanced...

Cancel

Figure 28 — TCP/IPv4 Properties.

address automatically’ from the TCP/IPv4 Properties window and clicking OK.
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Once both the computer and the network switch are on the same subnet IP range:

1. Open any web browser on the computer and type the IP address of the switch in the address bar. By
default, Cisco switches use the IP address 192.168.1.254.

2. This should open the switch configurations page (Figure 29). Type in the request username and
password. The default for the SG350-10 is “cisco” for both fields.

~ —= O £ 192,168.1.254 e x 7 &

alahe Switch
CIsCo Usemame:

ELGIERES English | |

Secure Browsing (HTTPS)

Figure 29 — Ethernet Status window.

Once connected to the switch and logged into the configurations page, it will be possible to access and adjust
each one of the configuration parameters.

DSCP Configuration for QoS Management
To configure DSCP parameters:

1. From the main switch configurations page, using the left-hand side menu, follow the path ‘Quality of
Service > General > QoS Properties’ and enable QoS Advanced Mode (Figure 30).

Getting Started
» Status and Statistics
> Administration QoS Mode: () Disable
» Port Management () Basic

» Smartport # Advanced
» VLAN Management
» Spanning Tree Apply H Cancel ]

MAC Address Tabl
s fess labies Interface Co§ Configuration Table
» Multicast

» IF Configuration Filter: Interface Type equals to
» Security (] Entry No.  Interface Default CoS
» Access Control L GE1
GE2
GE3
GE4
GE5
GE6
GET
GES
GE9
GE10

QoS Properties

ality of Service m
« General ()
0
Queue
CoS5/802 1p to Queue
DSCP to Queue U
Bandwidth L
Eqgress Shaping Per Queus O
VLAN Ingress Rate Limit
TCP Congestion Avoidance
» Q0S5 Basic Mode -
» QoS Advanced Mode Copy Settings... Edit... Restore Defaults
» QoS Siatistics
» SNMP

W = @ da W M
o o o o o o o o o o

-
=]

Figure 30 — Enabling QoS Advanced Mode.
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2. It is then necessary to change the settings from Layer 2 CoS management to Layer 3 DSCP. Under
‘Quality of Service > QoS Advanced Mode > Global Settings’, select DSCP as the ‘Trust Mode’, Trusted
as the ‘Default Mode Status’, and click ‘Apply’ (Figure 31).

Getting Started

Global Settings

» Status and Statistics

> Administration Trust Mode: CoS/802.1p

» Port Management e DSCP

» Smartport CoS/202.1p-DSCP

» VLAN Management Default Mode Status: e Trusted

» Spanning Tree Mot Trusted

» MAC Address Tables Override Ingress DSCP: Enable

¢ Multicast

» IP Configuration DSCP Override Table | [Apply—| |  Cancel
» Security

» Access Control

» General

» QoS Basic Mode

+ QoS Advanced Mode
Qut of Profile DSCP Mappin:
Class Mapping
Agaregate Policer
Policy Table
Policy Class Maps
Policy Binding

» QoS Statistics

» SNMP

Figure 31 — Global settings configuration.
3. Next, go to ‘Quality of Service > General > DSCP to Queue’, specify the priority output queue of each
DSCP label, and click ‘Apply’ (Figure 32). In Cisco switches, queue number 1 has the lowest priority,
while queue 4 has the highest.

The labels to which a priority must be given depending on the type of audio network in use.

For Dante AES67 (non-Audinate)
56 (CS7) 4 46 (EF) 4
46 (EF) 3 34 (AF41) 3
8 (CS1) 2 - 2
Everything else 1 Everything else 1

IMPORTANT NOTE:
Consult your network administrator in case the network presents other pre-existing systems, such as a LAN
VolP, as the settings above may need to be reviewed.
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Getting Started
» Status and Statistics DSCP to Queue
» Administration DSCP to Queue Table
» Port Management Ingress DSCP | Qutput Queue | Ingress DSCP | Output Queue | Ingress DSCP | Qutput Queue | Ingress DSCP | Output Queue
> Smartport 0 (BE) 'K 16 (CS2) 1w 32 (CS4) 1 48 (CS6) 1
» VLAN Management I 17 1w 2 Tv 40 Tv
» Spanning Tres 2 1v 18 (AF21) 1w 34 (AF41) 1w 50 1
+ MAC Address Tables 3 = 19 = a5 1e 51 e
» Multicast
4 1 20 (AF22) ir 36 (AF42) 1 52 1
» IP Configuration
- 5 i 21 1 37 1w 53 1
» Security
+ Access Control G 1w 22 (AF23) i 38 (AF43) 1 54 1
1v 23 1w 39 1w 55 1w
v General Sl E22 24(C83) iv 40 (CS5) 1v 56 (CS7) s
QoS Properties ] 1w 25 i 4 1 57 1
Queus 10 (AF11) 1v 26 (AF31) 1w 42 1w 58 1v
CoS/802.1p to Queue 11 1v 27 17 43 1 59 1
Ol Bres 12 (AF12) 1w 28 (AF32) 1v 44 iv B0 iv
Bandwidth
Egress Shaping Per Queue i ir = L i 1v 61 1r
VLAN Ingress Rate Limit 14 (AF13) 1w 30 (AF33) iv 45 (EF) 3w G2 1
TCP Congestion Avoidance 15 1 A ir A7 1 63 1
» QoS Basic Mode
» 00S Advanced Mode [—%] [ Cancel ] [ Restore Defaulis
o SEE Queue 1 has the lowest priority, gueue 4 has the highest priority.
r SNMP

Figure 32 — Configuration of DSCP queues.

Disabling Energy Efficient Ethernet (EEE)

To disable EEE in the Cisco switch:

1. From the main switch configurations page, using the left-hand side menu, follow the path
‘Port Management > Green Ethernet > Properties’ (Figure 33).

2. Untick the ‘802.3 Energy Efficient Ethernet (EEE)" enable box and click ‘Apply’.

Getling Started

»

Status and Statistics

Properties

»

Administration

Port Settings
Error Recovery Settings
Loopback Detection Settings
» Link Aggregation
» UDLD
» Green Ethernet

Fort Settings

Smartport

VLAN Management

Spanning Tree

MAC Address Tables

Multicast

IP Configuration

Security

Access Control

Quality of Service

¥ |[w v (w|w[w| w|w | wv|w

SNMP

Energy Detect Mode:
Short Reach:

Port LEDs:

Power Savings:

Cumulative Energy Saved:

802.3 Energy Efficient Ethernet (EEE):

For the functions and/or parameters configured on this page to become effective,
you may have to configure the corresponding port based parameters on Fort Settings page.

Enable

Enable
«| Enable
41 %

0 Watt Hour

Enable

[-appiy—| [ cancel

] [ Reset Energy Saving Counter

Figure 33 — Disabling EEE.
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Enabling and Configuring IGMP Snooping

To enable IGMP Snooping in the Cisco switch, for when multicast traffic is necessary:

1. From the main switch configurations page, using the left-hand side menu, follow the path
‘Multicast > Properties’ (Figure 34).

2. Tick the enable check box for ‘Bridge Multicast Filtering Status’.

3. Under ‘VLAN ID’, select the VLAN for which multicast traffic will be used. If no VLANs have been
configured, select 1.

4. Select IP Group Address for both ‘Forwarding Method IPv6’ and ‘Forwarding Method I1Pv4’.

Getling Started

Status and Statistics

Properties

Administration

Port Management

Smartport

VLAN Management

Spanning Tree

w (w | w|w | w|w|w

MAC Address Tables

MAC Group Address

IP Multicast Group Address
» |Pv4 Multicast Configuration
» |Pv6 Multicast Configuration

IGMP/MLD Snooping IP Multic

Multicast Router Port

Forward All

Unregistered Mulficast

IP Configuration

Security

Quality of Service

*
[
» Access Control
»
»

SNMP

Bridge Multicast Filtering Status:

VLAN ID:

Forwarding Method for IPvE:

Forwarding Method for |Pv4:

+ Enable

1

MAC Group Address
IF Group Address
Source Specific P Group Address

MAC Group Address
IP Group Address
Source Specific IP Group Address

[—Mpb[—] [ Cancel

Figure 34 — Setting up multicast properties.

5. Next, go to ‘Multicast > IPv4 Multicast Configuration > IGMP Snooping’ (Figure 35).

6. Select the enable check box for both ‘IGMP Snooping Status’ and ‘IGMP Querier Status’ and click

‘Apply’.
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Getting Started

Status and Statistics

IGMP Snooping

Administration

Port Management

Smartport

IGMP Snooping Status: (¢ Enable

IGMP Querier Status® || Enable

VLAM Management

Spanning Tree

> [ = [ = = [

—homiy— |

Cancel ] [ IGMP Snooping IP Multicast Group

MAC Address Tables

Properties

MAC Group Address

IP Multicast Group Address

IPv4 Multicast Configuration
IGMP VLAN Setftings

IPvE Multicast Configuration

IGMP/MLD Snooping IP Multid

Multicast Router Port

Forward All

Unregistered Multicast

4

-

|IP Configuration

Security

Access Control

Quality of Service

AEArAr AN

SNMP

IGMP Snooping Table

Entry No. | VLANID IGMP Snooping

Operational Status

MRouter Poris
Auto Learn

Immediate
Leave

Last Member
Query Counter

IGMP Querier
Status

IGMP Querier
Election

IGMP Querier
Version

Querier
IP Address

Copy Settings. | [ Edt

Figure 35 — Enabling IGMP Snooping.

7. To edit the IGMP Snooping settings, still on the same page, under IGMP Snooping Table’, select the
multicast VLAN ID and click ‘Edit”. This will open the ‘Edit IGMP Snooping” window (Figure 36).

8. Make sure the IGMP Snooping Status’ is enabled, as well as ‘MRouter Ports Auto Learn’.

9. Next, enable the IGMP Querier Status’, ‘IGMP Querier Election’, and set the ‘IGMP Querier Version’ to
IGMPv3 and click ‘Apply”. This is a recommended setting. As mentioned previously, Dante and AES67
both support IGMPv2 and IGMPv3. The important thing is that all switches in the network are
configured to run on the same version.

IMPORTANT NOTE:

% Last Member Query Counter: (s

IGMP Querier Status: o
IGMP Querier Election: vd

IGMP Querier Version:

Querier Source |IP Address: (s

VLAN ID: 1+

|GMP Snooping Status: +| Enable
MRouter Ports Auto Learn: «| Enable
Immediate Leave: Enable

Use Query Robusiness (2)

User Defined |

Enable
Enable

v2
v3

Auto
User Defined 16025402 v

il
&

]
@

]

Close l

Figure 36 — IGMP Snooping Settings.

Remember from the previous sections of this document that in networks using multiple switches, it is safer to
have only one IGMP Querier enabled, preferably on a switch sitting close to the root of the network topology.
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In this case, the functions in step 9 above should be disabled for all switches down in the connection chain and
that will not operate as IGMP Queriers.

Appendix

The following summary shows the relevant information to consider based on the AolP sources used in a
network that has been discussed at length above.

Dante Sources

. Dante
AR O DSCP Label DSCP Number
High Clock Sync Ccs7 56
Medium Audio Packets EF 46
Low Reserved CS1 8
None Others Best-Effort 0
Energy Efficient Ethernet Disable
Audio Stream Unicast/Multicast
IGMP Snooping Activated Yes
IGMP Version v2/v3
Patching Supported Dante Controller/A+/3rd Party
Mezzo AD, Duecanali DSP+D,
Amplifiers Supported (non-DMD) * Quattrocanali DSP+D, Ottocanali
DSP+D, T Series (non A), X Series
Mezzo AD, Duecanali DSP+D,
Amplifiers Supported (DMD) ** Quattrocanali DSP+D, Ottocanali
DSP+D, T Series (non-A), X Series

* AES67 mode needs to be enabled for Dante sources if want to patch to AES67 amplifier. Multicast AES67
streams needs to be created.

** On DMD, separate sources must be created for AES67 and Dante including a single Dante source with AES67
mode enabled. Multicast AES67 streams need to be created for a Dante source with AES67 mode enabled.
AES67 sources, either Dante based, or non-Dante based, can only be patched to AES67 based amplifier.
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AES67 Sources (Dante Based)

AES67 (Dante Based)

Priority Que Usage DSCP Label DSCP Number
High Clock Sync EF 46
Medium Audio Packets AF41 34

Low Reserved -

None Others Best-Effort 0

Energy Efficient Ethernet Disable
Audio Stream Multicast

IGMP Snooping Activated Yes
IGMP Version v2/v3

Patching Supported

Web Browser/A+/3rd Party
(coming soon)

Amplifiers Supported (non-DMD) *

Mezzo A+, Duecanali DSP+,
Quattrocanali DSP+

Amplifiers Supported (DMD) **

Mezzo A+, Duecanali DSP+,
Quattrocanali DSP+,

* patching a Dante amplifier with AES67 mode enabled with an AES67 enabled Dante source will only patch in

Dante mode, not AES67.

** On DMD, multicast AES67 stream needs to be created for Dante source with AES67 mode enabled. Patching

a Dante amplifier with AES67 mode enabled with an AES67 enabled Dante source will not work.
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AES67 Sources

Priority Que Usage AES67
DSCP Label DSCP Number
High Clock Sync EF 46
Medium Audio Packets AF41 34
Low Reserved -
None Others Best-Effort 0
Energy Efficient Ethernet Disable
Audio Stream Multicast
IGMP Snooping Activated Yes
IGMP Version v2/v3

Patching Supported

Web Browser/A+/3rd Party
(coming soon)

Amplifiers Supported (non-DMD) *

Mezzo AD & A+, Duecanali
DSP+D & DSP+, Quattrocanali
DSP+D & DSP+, Ottocanali
DSP+D, T Series (non A), X Series

Amplifiers Supported (DMD)

Mezzo A+, Duecanali DSP+,
Quattrocanali DSP+

* AES67 mode needs to be enabled for Dante amplifier.
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Dante, AES67 (Dante based) and AES67 Mixed Sources

Priority Que Usage AES67
DSCP Label DSCP Number
High Clock Sync Ccs7 56
Medium Audio Packets EF 46
Low Reserved CS1 8
None Others Best-Effort 0
Energy Efficient Ethernet Disable
Audio Stream Multicast
IGMP Snooping Activated Yes
IGMP Version v2/v3

Patching Supported

Dante Controller/A+/3rd Party

Amplifiers Supported (non-DMD) *

Mezzo AD & A+, Duecanali
DSP+D & DSP+, Quattrocanali
DSP+ Ottocanali DSP+D, T Series
(non A), X Series

Amplifiers Supported (DMD) **

Mezzo AD & A+, Duecanali
DSP+D & DSP+, Quattrocanali
DSP+ Ottocanali DSP+D, T Series
(non A), X Series

* Patching Dante amplifiers with AES67 mode enabled with an AES67 enabled Dante source will only patch in

Dante mode, not AES67.

** On DMD, separate sources must be created for AES67 and Dante, even with a single Dante source with
AES67 mode enabled. AES67 sources, either Dante based, or non-Dante based, can only be patched to AES67

based amplifier.
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